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Technology

sHTMLS5 / Canvas
eGoogle Web Toolkit
eVaadin Framework
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® OO0 Spreadsheet component XLS upload demo "

(P> | e | T }> http://localhost:8080/spreadsheet. & | (*§- Google Q

Upload a XLS file to view it
| Choose File |no file selected

t2 xls

Upload
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42.0
43.0
44.0
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http://jole.virtuall
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1764.0 1.62324923903973003
1849.0 1.6334684555795864
1836.0 1.6434526764861872
2025.0 1.6532125137753435
1.6627578316815739
0978579357173
2412373755872
1960800285134
1.6888700043360185
1.7075701760979363
1.716003343634799

reinstalled.com/spreadsheet

1.7558748556724912
1.7634279935629371
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https://github.com/jojule/spreadsheet
https://github.com/jojule/spreadsheet

‘e

public class SpreadsheetUploadDemo extends Root implements Receiver
{
Upload upload = new Upload(“Upload a XLS file to view it", this);
Spreadsheet spreadsheet = new Spreadsheet();

protected void init(WrappedRequest request) {
setCaption("Spreadsheet component XLS upload demo™);
Verticallayout vl = new Verticallayout();
vl.setMargin(true);
vl.setSizeFull(Q);
vl.addComponent(upload);
setContent(vl);
vl .addComponent(spreadsheet);
vl.setExpandRatio(spreadsheet, 1.0f);
spreadsheet. setGraphEnabled(true);

}

public OutputStream receivelUpload(final String filename, String mimeType) {
ByteArrayOutputStream baos = new ByteArrayOutputStream() {
public void close() throws IOException {
super.close();
spreadsheet.setCaption(filename);
spreadsheet. readXLS(new ByteArrayInputStream(this.toByteArray()));

}
¥s

return baos;
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<!doctype ntmi>
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Element

Description

<article> An independent piece of content for a document e.g. blog entry,
forum entry

<aside> A piece of content that is somehow related to the rest of the page

<audio> Audio media content

<canvas> A component for rendering dynamic bitmap graphics on the fly.
e.g games

<command> A command that the user can invoke: a button, radio button or checkbox

<datalist> Together with the new l1ist attribute for the <input> element can be used
to make combo boxes

<details> Additional information or controls that the user can obtain on demand, to
provide details on the document, or parts of it

<embed> Used for plug-in content

<figure> A piece of self-contained flow content referenced as a single unit from the

main flow of the document

<figcaption>

Caption for a <figure>

<footer> Footer for a section; may contain information about author, copyright
information, etc.

<header> A group of introductory or navigation aids

<hgroup> Header of a section

<keygen> A key pair generation control for user authentication in forms

<mark> A run of text in one document marker or highlighted for reference purposes




‘new sniny’



Cross-document CSS3

messaging Document
MTML i
Multimedia
WebGL Microdata
Offline storage Canvas
Markup
Improvements History
management
Forms

Geolocation Drag-and-drop File API



Canvas

state

state

state
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http://vj.jole.fi/
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http://vj.jole.fi
http://vj.jole.fi
http://localhost:48080/vj
http://localhost:48080/vj

#151

Get More Refcardz! Visit refcardz.com

HTMLS5 Canvas

® Introduction to Canvas

* Browser Support and Hardware Acceleration
* What Canvas Can and Cannot Do

= A Comparison with SVG

= Canvas Performance

= Creating a Canvas and

INTRODUCTION TO CANVAS

The HTML <canvas> element allows for on-the-fly creation of graphs,
diagrams, games, and other visual elements and interactive media. It also
allows for the rendering of 2D and 3D shapes and images, typically via
JavaScript.

" height="500"></canvas

text/jave pt”>
r can cument.getElementById(‘canv: N3
ctx = can.getContext(‘2d’);

fillText (“Hello World!”, 50, 50);
</script>

Canvas is perhaps the most visible part of the new HTMLS feature set,
with new demos, projects, and proofs of concept appearing daily.

Canvas is a very low-level drawing surface with commands for making
lines, curves, rectangles, gradients and clipping regions built in. There is
very little else in the way of graphics drawing, which allows programmers
to create their own methods for several basic drawing functions such

as blurring, tweening, and animation. Even drawing a dotted line is
something that must be done by the programmer from scratch.

Canvas is an immediate drawing surface and has no scene graph. This
means that once an image or shape is drawn to it, neither the Canvas nor
its drawing context have any knowledge of what was just drawn.

For instance, to draw a line and have it move around, you need to do
much more than simply change the points of the line. You must clear
the Canvas (or part of it) and redraw the line with the new points. This
contrasts greatly with SVG, where you would simply give the line a new
position and be done with it.

You can visit the evolving specification for Canvas at the WHATWG site:
http://www.whatwg,.org/specs/web-apps/current-work/multipage/
the-canvas-element.html.

Browser Support and Hardware Acceleration
Canvas is supported by Firefox 1.5 and later; Opera 9 and later; and
newer versions of Safari, Chrome, and Internet Explorer 9 and 10.

The latest versions of these browsers support nearly all abilities of the
Canvas element. A notable exception is drawFocusRing, which no
browser supports effects.

Hardware acceleration is supported in some variation by all current
browsers, though the performance gains differ. It is difficult to benchmark
between the modern browsers because they are changing frequently, but
so far IE9 seems to consistently get the most out of having a good GPU.
On a machine with a good video card it is almost always the fastest at
rendering massive amounts of images or canvas-to-canvas draws.

Accelerated |E9 also renders fillRect more than twice as fast as the other
major browsers, allowing for impressive 2D particle effects [1]. Chrome
often has the fastest path rendering but can be inconsistent between
releases. All browsers render images and rects much faster than paths or
text, so it is best to use images and rects if you can regardless of which
browsers you are targeting.

HTML 5 Canvas

A Web Standard for Dynamic Graphics

By Simon Sarris

Support

Stateful-
ness

Other
Considel

ations

Accessi-
bility

® All modern versions of Chrome,
Safari, Firefox, and Opera have at
least some support. Internet Explorer
9+ has support. Almost all modern
smart phones.

¢ Internet Explorer 7 and 8 have
limited support through the excanvas
library.

* Rapidly growing in popularity

 Bitmapped, immediate drawing

surface

* Shapes are drawn and nothing is

remembered about their state.

* Generally faster
= ¢ All event handling and statefulness
must be programmed yourself.
 Canvas will be effectively disabled
(rendering nothing) if scripting is

disabled

* Difficult to interface with other

DOM objects

* Working with text can be difficult.

® Recreating ased DOM ele-

ment functional strongly advised
gainst, even in the specification

itself.

* Cannot operate when scripting is

disabled

® SVG support in all modern brows-

ers. Almost all modern smart phones.

 Vector-based, retained drawing
surface

® Ev awn shape is a DOM object.

* Generally slower, especially past
10,000 objects.

* Since all SVG elements are DOM
objects, statefulness is built in and
event handling is much easier.

o Easier for a designer to work with,
many programs such as lllustrator can
output SVG

® SVG has built-in support for
animation

* All SVG objects are already DOM
objects.

 Text is searchable by the browser

and web crawlers.

WindowseInternet

- & Explorer9

//Enhance your site
//with pinning today
//It takes less than an hour

buildmypinnedsite.com

DZone, Inc. | www.dzone.com

Get the code
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\C

Google Web Toolkit



Subset of
java.lang, java.util

Java to
JavaScript
Compiler

Your Application Ul




simpler

e 100% Java

e Static typing

e Object orienteo
e -xcellent tooling



less bugs

e Stop debugging
Javascript spaghett

® |gnore most
browser differences
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client-side

e Ul In client

e Asyncronous RPC
e Services (for Ul)
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Vaadin is a
Ul framework
for rich web
applications







Web application layers

Backend Web Java to
RPC .
server server JavaScript

GWT Vaadin

JS

Javascript
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Vaadin Ul component
architecture

Java

e Compiled with JDK
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How does it
work, really?
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e |nitial HTML
e CSS (theme)
* |mages

e JavaScript

250k total
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00 Mozilla Firefox
1> http://localhost...startApplication e

}> localhost 77 v @ [ iv Google Q)|#

* name="Joonas”
e putton clicked

150 bytes
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public void buttonClick(ClickEvent event) {
maitnWindow.showNotification("Hi " + name);

}
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® OO0
| }> http://localhost...startApplication

Mozilla Firefox

y || }> localhost 77 v @ [[{ i~ Google Q)|

e name="Joonas”
e putton clicked

150 bytes

4

e Ada
notification

466 bytes
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A

DASHBOARD

-

My Dashboard # o

TOP GROSSING MOVIES o NOTES o

Remember to:
- Zoom in and out in the Sales view

- Filter the transactions and drag a set of them to the Reports
tab

- Create a new report

+ Change the schedule of the movie theater

R0

Y-values

BB Parker B Hansel and Gretel: Witch Hunters Movie 43
B Monsters, Inc. 3D I Zero Dark Thirty [l Silver Linings Playbook

http://demo.vaadin.com/

TOP 10 TITLES BY RE dashboard o

O 00 N O nn & W N =

-
o

Title
7 Parker
Skyfall /
Wreck-it Ralph $56978.32 ver Linngs Playbook Hansel and Gretet: W
Lincoln $55928.02 Mo s
Silver Linings Playbook $54418.14
Life of Pi $50882.59
Flight $48055.12
Monsters, Inc. 3D $41058.53 — Monsters, Inc. 3
Rise of the Guardians $34406.37
Django Unchained $34352.09 Zero Dark Thirty

Zero Dark Thirty $29014.34

Vaadin Charts



http://demo.vaadin.com/dashboard
http://demo.vaadin.com/dashboard
http://demo.vaadin.com/dashboard
http://demo.vaadin.com/dashboard

Carrier =

Mailboxes

sit@ipsum.com

~IrMmoa tempor

ut@clita.com

69605: Aliquyam

takimata@dolor.com

&6. Dolor sit amet

justo@eirmod.com

0L Ma jna aquyam

elitr@aliquyam.com

14630: Dolor sit amet, consetet

Updated 10/3/11 09:13

12:25 PM 100 % -.)

) sea takimata sanctus est

rebum, Stet clita kasd gubergren, no sea takimata sanctus

sum dolor sit amet, consetetur sadipscing elitr, sed diam

3:31 PM

. Carrier =
et dolore magna aliquyam erat, sed diam voluptua. At vero

ebum, Stet clita kasd gubergren, no sea takimata sanctus Mailboxes

1 dolor sit amet, consetetur sadipscing elitr, sed diam

it dolore magna aliquyam erat, sed diam voluptua. At vero
& J Pl Accounts
sea takimata sanctus

g elitr, sed diam .
: Vmail

Hotvail

olore magna aliquyam erat, sed diar

Vahoo!

vCloud

C Updated 9/30/11 12:31
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o
vqodln }> Demo Learn Community Services Company QrSearch

Releases Add-ons Tooling Roadmap

4 N
Q Search Add-ons «Previous Next» 91 2 3 4 5 6 7 8 9 10 11 12 .. 27 316 Results
All versions v
CSValidation SimpleCalendar
In Ul Components by Marko Gronroos In Ul Components by John Ahlroos
BrOWSG Client-side validation of text fields Date selection made easy.
Ul Components Version 0.5.1 BETA * % % % 3 § 1220 Version 0.1 EXPERIMENTAL No ratings yet $2
Data Components
Themes PopupButton Number Field
Tools In Ul Components by Henri Kerola In Ul Components by Francesco Portus
Miscellaneous Button with popup Numeric text field that allows insert only a valid numbers
with keyboard and also allows spin value up/down.
Official
. ) Version 2.2.0 BETA * % % % 19 $ 8546 Version 1.0.2 BETA * kKX ¥y 2 3 99
Guest . .
. ExternalLayout FilterableTwinColSelect
uthoring In Ul Components by Risto Yrjana In Ul Components by Kim Leppanen
ExternalLayout allows Vaadin components to be rendered An improved version of the core's TwinColSelect, allows
Subscribe RSS outside the normal Vaadin application DOM-hierarchy you to filter values
Help
FAQ Vi x STABLS * %k ok k 1 3 186 Version 1.0.0 EXPERIMENTAL No ratings yet 31
Feedback
MockupContainer Jain H8N

In Data Components bv Risto Yriana In Data Components bv Lokesh Jain



Download for Free

~700 pages




Designing
Step-by-step
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Need
We can not get

the UX we need
with the existing
widgets




o | |Stotf
® real
e quantifiable

® requirements
o for UX



Example goals

e | pad and view data in XLS files

e Show visual overview for numeric cols
e Must support 1000 cell tables

e Supports the latest Firefox & Chrome

vaadin }>



Nail down

the minimum viable
set of supported
browser versions
with the customer



Idea

'how It Is used]
.|.
Tech [how it works]



Sample

== I I~ » B 40 I % N % I

[N S [N (V) N I I T T N e

aRBY

a5 A H oA 5 A W W w

Measured value

9,983341664633
19,86693307951
29,55202066613
38,94183423087
47,94255386042
56,4642473395
64,42176872377
71,73560908995
78,33269006275
84,14700848079
89,12073600614
93,20390859672
96,35581854172
98,54497299835
99,74949866041
99,95736030415
99,16648104525
97,38476308782
94,63000876874
90,92974268257
86,32093666439
80,84964038196
74,57052121767
67,54631805512
59,8472144104
51,55013718215
42,73798802338
33,49881501559
23,9249329214
14,11200080599
4,158066243329
-5,837414342758
-15,77456941432
-25,55411020268
-35,07832276896
-44,25204432949
-52,98361409085
-61,18578909427
-68,7766159184
-75,68024953079
-81,82771110644
-87,15757724136
-91,61659367495
-95,16020738895
-97,75301176651
-99,36910036335
-99,99232575641

Date

1.1.2012
2.1.2012
3.1.2012
4.1.2012
5.1.2012
6.1.2012
7.1.2012
8.1.2012
9.1.2012
10.1.2012
11.1.2012
12.1.2012
13.1.2012
14.1.2012
15.1.2012
16.1.2012
17.1.2012
18.1.2012
19.1.2012
20.1.2012
21.1.2012
22.1.2012
23.1.2012
24.1.2012
25.1.2012
26.1.2012
27.1.2012
28.1.2012
29.1.2012
30.1.2012
31.1.2012
1.2.2012
22.2012
3.2.2012
42.2012
5.2.2012
6.2.2012
7.2.2012
8.2.2012
9.2.2012
10.2.2012
11.2.2012
12.2.2012
13.2.2012
14.2.2012
15.2.2012
16.2.2012
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Sample

©@N® NS ©N a

wh wh b b o e A A A A
N IR I I G

R R

PN
-~

SHREN 2588988882833 338R

Measured value Date
0,083341664633 1.1.2012
10,86603307951 2.1.2012
29,55202066613 3.1.2012
38,94183423087 4.1.2012
47,94255386042 5.1.2012
56,4642473395 6.1.2012
84,42176872377 7.1.2012
71,73560908995 8.1.2012
78,33269006275 9.1.2012
84,14700848079 10.1.2012
89,12073600614 11.1.2012
93,20390859672 12.1.2012

06,35581854172
08,54407299885
99,74949866041
99,05736030415
90,16648104525

67,54631805512
59,8472144104

51,55013718215
42,737
3;428:3853?52: Avg: 0.95 Count: 182 Sum: 172.23
23,0249329214 97201
14,11200080599 30.1.2012
4,158086243320 31.1.2012
-5,837414342758 1.2.2012
-15,77456041432 222012
-25,55411020268 3.2.2012
-35,07832276806 4.2.2012
-44,25204432949 5.2.2012
-52,98361409085 6.2.2012
-61,18578009427 7.2.2012
-68,7766150184 8.2.2012
-75,68024053079 9.2.2012
-81,82771110644 10.2.2012
-87,15757724136 11.2.2012
-01,61659367495 12.2.2012
-05,16020738895 13.2.2012
-97,75301176651 14.2.2012
-09,36910036335 15.2.2012
-99,09232575641 16.2.2012
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Always start from
defined goals -
never let idea to
rule your design






. v-spreadsheet
. v-spreadsheet
. v-spreadsheet
. v-spreadsheet
. v-spreadsheet
.v-spreadsheet
. v-spreadsheet
. v-spreadsheet

</style>
</head>
<body>

.rowl3 { height: 12px; top: 177px;}
.rowl4 { height: 12px; top: 199px;}

.coll { width: 99px;
.col2 { width: 99px;
.col3 { width: 99px;
.col4 { width: 99px;
.col5 { width: 99px;
.colé { width: 99px;

<div class="v-spreadsheet" id="elem">
<div class="sheet" id="sheet">

<div
<div
<div
<div
<div
<div
<div

<div
<div
<div
<div
<div
<div
<div

<div

class=
class=
class=
class=
class=
class=
class=

class=
class=
class=
class=
class=
class=
class=

class=

coll rowl'"></div>
col2 rowl'"></div>
col3 rowl'"></div>
col4 rowl'"></div>
col5 rowl'"></div>
colé rowl'"></div>

"rh rowl's1</div>

coll row2"></div>
col2 row2"s</div>
col3 row2"></div>
col4 row2'"></div>
col5 row2"></div>
col6 row2'"></div>

"rh row2's2</div>

"C

coll row3"></div>

left:
left:
left:
left:
left:
left:

50px;}
150px;}
250px;
350px;
450px;
550px;

et gl g g

SO NOU L WN -

Works with
target browsers?
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}

padding-top: Zpx;

Interactions
porder-botton: 7ox solid #ddbdts work with target
border-top: 1px solid #d6déde6;

browsers?

</style> _> o
</head> Performance is

<body>

<div class="v-spreadsheet" 1d="elem"> gOOd enough for

<div class="sheet" 1d="sheet'>

v target data?

</div>

<script>
var totalrows = 100;
var totalcols = 13;
var isIE = navigator&&navigator.userAgent&&navigator.userAgent.match(/\bMSIE ([678])\./);
function insert(SS(css) {
var stylesheet = document.styleSheets[@];
Ay LisiE) ¢
stylesheet.cssText += css;
} else {
stylesheet.insertRule(css, stylesheet.cssRules.length);
}

}
document.getElementById("elem").onscroll = function() {

var e = document.getElementById("elem");
var 1 = e.scrollleft;
var classes = document.styleSheets[@].rules || document.styleSheets[@].cssRules

N vaadin }>



Proto DOD

® |ncludes main use-cases
o \Vorks In target browsers
® Handles enougnh data
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Never start design

or implementation
before prototyping
browser compatibility
and performance






Design UX and
API first.

Never continue
from
the prototype
implementation




Drawing detailed
wireframes & mockups
and testing them with
users will save

time later



 sheets I
o

== Table 1

Basic (No Grid)
1] Gray

[T Gray Headers
@ Gray Fill

[ Beige

™ Ledger

[T Blue

[~ Blue Headers
Blue Fill




Shamelessly copy UX.
Then your users

already
know how to use it.







Aim for multilayered
design that lets your
users (developers)
change behavior of
your component
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DOM classes and
CSS restrictions
must be documented
to make styling easy







Keep component
project separate
from your real
application project



Demo application
must include all
features

and serve as example
for your users



v :;ﬁ” spreadsheet [spreadsheet master]
¥ (#B src/main/java
¥ {3 org.vaadin.spreadsheet
» [J} Spreadsheet.java
¥ {3 org.vaadin.spreadsheet.gwt
¥ (5 public
¥ (5 spreadsheet
= styles.css
¥} SpreadsheetWidgetSet.gwt.xml
¥ {3 org.vaadin.spreadsheet.gwt.client
J) SpreadsheetConnector.java
J) SpreadsheetModel.java
J) SpreadsheetState.java
J) SpreadsheetView.java
X| rebel.xmi
58 src/test/java
» =, JRE System Library [J2SE-1.5]
» =, Maven Dependencies
> (57 design
P Gy src
P (= target
1| licensing.txt
%) pom.xml
% README.markdown

X v vvw



Invest in project

setup with a rapid
save-to-see cycle and a
robust build script.
These might not be the
same thing.



Component Add-on Project Setup HOWTO

This howto walks you through a complete setup for a project for developing, building and publishing your own Vaadin Ul component add-ons. The goal
here is not to teach how to write an add-on, but to make the process of setting up your project environment as smooth as possible. | hope this
encourages you to try building and publishing your own add-ons :)

Goals for the project environment

« Fully automated build with Maven
« Allow anyone to re-build your project easily regardless of the IDE:s
« Almost instant save-build-deploy-try cycle

https://vaadin.com/wiki/-/wiki/Main/

Component+Add-on+Project+Setup+HOWTO

« Eclipse IDE for Java EE developers from htip://www.eclipse.org (Indigo Service Release 1 was used in this howto)
+ Google Chrome browser from https://www.google.com/chrome/ (other browsers will do, but Chrome is recommended)
« Eclipse plugins: m4e-wtp, vaadin, egit (optional) and jrebel (optional) from Marketplace (just select Help->Marketplace... from the menu)

Create a new widget project

Start project creation wizard: File -> New -> Other... -> "Maven Project”
Give a proper name for your project and save it under workspace. For this exapmle | am building a list widget and name it MyList.
Ensure that your Maven architype catalogs contain http://repo1.maven.org/maven2/archetype-catalog.xml as remote catalog and select it.

Select vaadin-archetype-widget from the list.


https://github.com/jojule/spreadsheet
https://github.com/jojule/spreadsheet
https://github.com/jojule/spreadsheet
https://github.com/jojule/spreadsheet




There is no substitute
for manual testing and
user experience testing



Skip test driven
development, but invest
In regression testing




Pixel level regression
tests take time to set
up, but will be worth it



Never trust that

your changes would not
break other browsers
and skip cross-browser
testing



It iIs impossible to use
too much time In
polishing UX for a
reusable component.






gith“b Q Ssearch... . Explore Gist Blog Help &3 iojute 8P % [
) jojule/spreadsheet 4 Admin  © Unwatch ¢ Fork (i1 PullRequest @1 / 1

Code Network Pull Requests 0 Issues O Wiki 0 Stats & Graphs

Simple spreadsheet component for Vaadin — Read more
https://vaadin.com/addon/spreadsheet

& Clone in Mac =1 ZIP & HTTP  Git Read-Only git@github.com:jojule/spreadsheet.git Read+Write access

A branch: master ~ Files Commits Branches 1 Tags Downloads

name age message history
(2 design a day ago Developing [Joonas Lehtinen]

2 src 19 hours ago Version 0.1 [Joonas Lehtinen]

= README.markdown 4 hours ago Update README.markdown [jojule]

= licensing.txt 19 hours ago Version 0.1 [Joonas Lehtinen]

= pom.xml 18 hours ago Fixed add-on name [Joonas Lehtinen]

E2 README.markdown


https://github.com/jojule/spreadsheet
https://github.com/jojule/spreadsheet

README.markdown

Spreadsheet for Vaadin

The widget shows a spreadsheet - either from XLS file or by setting the cell contents programmatically.

This version is very limited and should be considered to be an early alpha -version. Try out the demo to see if it would be useful for you. |
mainly built it for an upcoming presentation.

SpreadsheetView class should be also usable in GWT without Vaadin Framework, but then you must implement SpreadsheetModel by
yourself.

Dependencies

e Apache POI 3.8 - http://poi.apache.org/

e Apache Commons Codec 1.5 - Required by POI - hitp://commons.apache.org/codec/

Release notes

Initial release with severe limitations:

All columns and rows have fixed sizes

e No cell styling is supported

¢ No graphs are supported

¢ No merged cells are supported

¢ Performance for larger spreadsheets is really bad

¢ Only one spreadsheet widget is supported on screen at once

License & Author



preadsheet/src/main/java/org/vaadin/spreadsheet/gwt/SpreadsheetWidgetSet.gwt.xml - Eclipse - /Users/phoenix/dev/workspace

EdS A 22 B[] v ey B O & & 32
<‘-'=’(> e - =) (@ SpreadsheetState.java ([Z] SpreadsheetWidgetSet.gwt.xml 23\

| <|--

_llnrmnl—_i-hn_fallamm_i-n romni la_thn_undnotset for one browser only.
-GN S N— Select Configuration nificantly when debugging.

ent to production

Select a launch configuration to run: g

m2 spreadsheet (1) : gwt:run

@A spreadsheet (2) : package

m2 spreadsheet (3) : war:war

m2 spreadsheet (4) : update-widgetset
m2 spreadsheet (5) : widgetset-update o
m2 spreadsheet (6) : later and safari is used
m2 spreadsheet (7) : package rome .

m2 spreadsheet : jetty:run

9.3 as a comma separated
. of writing were:

/>

Ex &8

o4 803

@)
(ot F

ons/1.6.0/Home/bin/java (Apr 15, 2012 8:14:44 PM)

[INF
2012

JReb

Jkebel' Virectorvy "Zleer<s/nhoeni x/dey

——— b

T o o T e e e ol e

JA

/target/classes' will be monitored for changes.

t/target/test-classes' will be monitored for changes.
2012-04-15 20:14:54 .631:INFO: :No Transaction manager Found - 1f your webapp requires one, please configure one.

2012-04-15 20:14:54 .997:INFO: :Started SelectChannelConnector£d.9.0.0:8080
[INFO] Started Jetty Server

Apr 15, 2012 8:15:08 PM com.vaadin.terminal.gwt.server.AbstractApplicationServlet checkProductionMode

WARNING:

b AL _L_L_2_JL_¢_ 2 2 2 2L 2 24 2 4 4 2 _o_o o _ 0 ot 0 L L 0 _L_L_L_L_2L_2L_¢ 2 L _2 2 2 2 2 4 _2_ o 20 o 0 o 4 _o_L_L 4 _L_L_4_2_2J_2_2L J_2_J

Vaadin is running in DEBUG MODE.
Add productionMode=true to web.xml to disable debug features.
To show debug window, add ?debug to your application URL.




Vaadin Add-on Package Export

Define which resources should be exported into the Vaadin add-on package.

Select the resources to export.
E > {1;‘—;’-test

Manifest:
Implementation title: My Fancy Widget

Name of the add-on. Used in Vaadin Directory.

Implementation version: 1.0.0

Version of the addon. A "major.minor.revision" format is suggested.

Widgetsets: com.example.test.TestWidgetset

Comma separated list of widgetsets included in the add-on. Refers to the GWT xml files (.gwt.xml).
Select the export destination:

JAR file: B ( Browse... )

Options:
() Overwrite existing files without warning

@ ( <Back ) ( Next> ) ( cancel ) ( Finish )

/.

vaadin }>



Upload New Add-on

Select a category to post your new add-on to.

Note, that if you're updating a previous add-on, that is done by editing the add-on from the list above.
o
{':7 Ul Components \/ & Themes ." Data Components
Server-side and/or client-side Themes for Vaadin applications Components related to the
Ul components Vaadin data model, e.g.
Container or Validator
implementations
X Tools OO Miscellaneous
Tools for Vaadin developers Other Vaadin add-ons

vaadin }>



o
vqodln }> Demo Learn Community Services Company QrSearch

Releases Add-ons Tooling Roadmap

4 N
Q Search Add-ons «Previous Next» 91 2 3 4 5 6 7 8 9 10 11 12 .. 27 316 Results
All versions v
CSValidation SimpleCalendar
In Ul Components by Marko Gronroos In Ul Components by John Ahlroos
BrOWSG Client-side validation of text fields Date selection made easy.
Ul Components Version 0.5.1 BETA * % % % 3 § 1220 Version 0.1 EXPERIMENTAL No ratings yet $2
Data Components
Themes PopupButton Number Field
Tools In Ul Components by Henri Kerola In Ul Components by Francesco Portus
Miscellaneous Button with popup Numeric text field that allows insert only a valid numbers
with keyboard and also allows spin value up/down.
Official
. ) Version 2.2.0 BETA * % % % 19 $ 8546 Version 1.0.2 BETA * kKX ¥y 2 3 99
Guest . .
. ExternalLayout FilterableTwinColSelect
uthoring In Ul Components by Risto Yrjana In Ul Components by Kim Leppanen
ExternalLayout allows Vaadin components to be rendered An improved version of the core's TwinColSelect, allows
Subscribe RSS outside the normal Vaadin application DOM-hierarchy you to filter values
Help
FAQ Vi x STABLS * %k ok k 1 3 186 Version 1.0.0 EXPERIMENTAL No ratings yet 31
Feedback
MockupContainer Jain H8N

In Data Components bv Risto Yriana In Data Components bv Lokesh Jain



Join Vaadin LogIn

vaadin

\

84 Directory | PaperStack

In Ul Components by Tomi Virkki **x%x%x 11 § 194 Report this add-on
Q

Browse Version 0.8.1 (latest) v Download Now

Version 0.8.1 (86 kB)
O | vaturity EXPERIMENTAL Browser Compatibillty

Ul Components License A - @ s , )
pache License 2.0
Data Components | ®s5 6 Maven POM
Vaadin 6.2 upwards e 7 8

Themes O 10

Tools @ 3 4 5 Related Links

Miscellaneous Discussion Forum
\. ) Overview Online Demo

Source Code
PaperStack is a component container whose subcomponents are

Guest
A presented sequentially, one subcomponent at a time. User can switch

' between the subcomponents by mouse dragging the upper right corner of

a view revealing the underlying subcomponent simultaneously. The Share

Subscribe RSS transition effect simulates leafing through a stack of papers.
Help » RS e | &3 More...
FAQ Highlights
Feedback

4 N
package org.vaa

, Permalink to this add-on:

http/ivaadin.com/addon/paperstack
import com. vaad

mport com. vaad

public class MyA
N o
Code Example Screenshot 2 Screenshot 1

Release notes

r. .. -



Demo Download Learn Discuss Contribute

' vaadin }>

B Directory | PaperStack
Q Paperstack - Screensho

Browse

Ul Components
Data Components

Themes e Currentview is the first subcomponent added to this the paper edge
switch to the next subcomponent either by dragging 5

Tools mouse or by clicking on it once.

Miscellaneous ar back

o PaperStack is a ComponentContainer. Any Vaadin
Some Field components in a FormLayout below...

Authoring Birthday | e

First name
en v

__Eye liek pie

PN

n/paperstack

T

Code Example Screenshot 2 enshot 1

Release notes



vaadin

\

4 Directory

Q

Browse

Ul Components
Data Components
Themes

Tools
Miscellaneous

Guest
Authoring

Subscribe RSS
Help

FAQ

Feedback

Join Vaadin

Log In

PaperStack

In Ul Components by Tomi Virkki **x%x%x 11 § 194
Version 0.8.1 (latest) v
Maturity EXPERIMENTAL Browser Compatibility

& 3

A8 A A B £S5

PaperStack - Code Example
PaperStack paperStack = new PaperStack();
paperStack.addComponent (new Label ("Hello!"));
InlineDateField inlineDateField = new InlineDateField():;
inlineDateField.setResolution (DateField.RESOLUTION DAY) ;

paperStack.addComponent (inlineDateField, "#999");

mainWindow.addComponent (paperStack) ;

Report this add-on

Download Now
Version 0.8.1 (86 kB)

ted Links

Bcussion Forum

/ﬁn.. € | E3 More...

- -
'S \ s
package org.vaa
import com vaad
.-
mport com. vaad
—
public class MyA
. . 8

Code Example Screenshot 2 Screenshot 1

Release notes

r. .. -

Permalink to this add-on:

http/Avaadin.com/addon/paperstack



Join Vaadin LogIn

vaadin
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,
8 Directory | PaperStack
In Ul Components by Tomi Virkki **x%x%x 11 § 194 Report this add-on
Q
Browse Version 0.8.1 (latest) v Download Now
Version 0.8.1 (86 kB)
EEEEE | vaturity EXPERIMENTAL Browser Compatibility
. : 3
Ul Components License Apache License 2.0 : =\ (8 Maven POM
Data Components . ' R ks
Vaadin 6.2 upwards e 7 8
Themes 0 10
<dependency>
Tools @ 3 45 <groupld>org.vaadin.addons</groupld>
<artifactid>paperstack</artifactid>
Miscellaneous <version>0.8.1</version>
</dependency>
\ y Overview ,
<repository>
<id>vaadin-addons</id>
Guest PaperStack is a component container whose subcomponents are <url>httpz/maven.vaadin.com/vaadin-
oy presented sequentially, one subcomponent at a time. User can switch SIONS=AE
between the subcomponents by mouse dragging the upper right corner of
a view revealing the underlying subcomponent simultaneously. The
Subscribe RSS transition effect simulates leafing through a stack of papers. Related Links
Help Discussion Forum
FAQ Highlights Online Demo
Feedback

Source Code

{ ' '
JCKD0C Org.vad
import com ) v
mport com . ' e
lass My Share
. . N
Code Example Screenshot 2 Screenshot 1

» RS QB More...

Release notes : :
Permalink to this add-on:

r. .. -



o= Outline S5l L e

V¥ i=> PostitNotes
B ‘Q@ Deployment Descriptor: PostitNotes
Vgﬁjava Resources: src

w m oy o avarmnla nactitnarac

~ Your client side code in the project PostitNotes might need a recompilation.
\o\/ Compile widgetset now?

() Suspend automatic recompilation

( No o0 Yes )

» (= VAADIN
¥ (= WEB-INF
¥ (= lib
&% paperstack-0.8.1 jar
&% vaadin-6.5.1.jar
X web.xml




Try out my Spreadsheetl




® 00 Issues - jojule/spreadsheet &
’ |2« | + @https://githubcom/jojulelspradsheet/issues | GitHub, Inc. (53 & | (*§- Google | 1€

github (' Explore Gist Blog Help a jojule *P %’ [+

+ Admin © Unwatch & Fork (i1 Pull Request ©1 /1

Pull Requests © Stats & Graphs

Browse Issues Milestones Search: | Issues & Milestones... Q  NewIssue

. yboard shortcuts available
Everyone’s Issues

R https://github.com/jojule/ e
spreadsheet/issues

No milestone selected

Labels
B bug

duplicate
§ enhancement

invalid

# question

wontfix


https://github.com/jojule/spreadsheet
https://github.com/jojule/spreadsheet
https://github.com/jojule/spreadsheet
https://github.com/jojule/spreadsheet

® 00 New Issue - jojule/spreadsheet a8 W
g GitHub, Inc. 55 & a"Google RE* )

#%|  + @ https://github.com/jojule/spreadsheet/issues/new

Pull Requests 0 Stats & Graphs

Browse Issues  Milestones Search: | Issues & Milestones... Q -“e'

Add Labels

Title
w bug ]
Does not work properly if there are two instances of the component | duplicate

Il enhancement
invalid
§ question

No one is assigned £+ No milestone &+

("m' Preview Comments are parsed with GitHub Flavored Markdown wontfix

When two instances of the Spreadsheet are put to screen at the same time, scrolling either scrolls the headers in both. This
makes the component unusable for any screens with two spreadsheets.

Submit new issue




Issues - jojule/spreadsheet

#%|  + @ https://github.com/jojule/spreadsheet/issues GitHub, Inc. (53 & | (°§- Google

() Explore Gist Blog Help £ ioiute *F % [»

4 Admin © Unwatch & Fork (i PullRequest ©1 (1

Stats & Graphs

Browse Issues Milestones

Everyone’s Issues L

Assigned to you 0

Mentioning you

No milestone selected

Labels
#bug

J duplicate

§ enhancement
invalid

§ question

wontfix

Search: | Issues & Milestones... Q  Newlssue

No active filters. Use the sidebar to filter issues. Keyboard shortcuts available

‘ 1openissue 0 closed Issues l\"&lw. Updated Comments

Close Label v Assignee v Milestone v

#1  Does not work properly if there are two instances of the component ]
by jojule just now

1 open issue in this view



Support HOWTO

lgnore. wont-fix in best case.
(the usual open source way)

Fix after 6 months,
maybe...

Fix immediately and thank
the user who reported it

vaadin }>
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